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Overview
Dolby Atmos フォーマットでコンテンツを作成するには、スタジオのスピーカーにレンダリングされた音声をリア
ルタイムで出力する Dolby Atmos Renderer システムを通してミキシングとモニターを行う必要があります。

これは、制作ツールが音声（プロトコルは問わないが、通常は DANTE または MADI経由）とパンニング メタ
データ（ネットワーク接続経由）の両方を、以下の Dolby Atmos Renderer システムのいずれかに送信するこ
とを意味します：

● Dolby Atmos Production Suite (DAPS)

● Dolby Atmos Mastering Suite (DAMS)

● Dolby Atmos Home Entertainment RMU (HT-RMU) available in various configurations

● Dolby Atmos Theatrical RMU

Pyramixはオーディオとメタデータを DAPS, DAMS, HT-RMUに送ることができます。

Note: Dolby Atmos Master Import/Export/Editingには Pyramix Premiumのライセンスが必要です。

Dolby側は Version 3.7のソフトウェア コンポーネントを推奨しています。
Theatrical RMUは、現在サポートしていません。

Configurations and Options
Dolby Atmosの設定については Dolby社の代理店にお問い合わせください。
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Importing a Dolby Atmos ADM Master file
ADMファイルは BWF wavファイルで、必要なオーディオトラック、メタデータ、ダイナミックイベント（オートメー
ションデータ）が含まれています。

ADM Masterファイルをインポートするには、Project > Import Dolby Atmos Masterに進みます。
次にブラウズしてADM Masterファイルを選択します。

適切な Dolby Atmos Master ファイルが選択されると、以下のオプションが提供されます：
ファイルの特性、サンプルレート、フレームレート、ビットレート、開始時間などの概要が左上に表示されます。

Timeline Settings
● Place at Master Start Time - ADMファイルで指定された位置にADMをインポートします。ADMをビ

デオと同期させるために重要です。

● Place at Cursor - カーソル位置に ADM をインポートします。

注意：どちらの場合も、Mark In と Mark OutがインポートされたADMの最初と最後に付けられ、 FFOA とい
う名前の First Frame of Action（オレンジ色）マーカーがタイムラインの適切な位置に追加されます。

● New Timeline -現在のタイムラインを消去し、新しいタイムラインで置き換えます。
プロジェクトにはインポートした ADMの名前が付けられます。

● Paste on existing Tracks -既存のタイムラインを維持し、ADM ファイルを既存のトラックに挿入し
ます。この機能は複数の ADM ファイルを１つのプロジェクトにまとめる場合に便利です。最初の ADM
を上記の New Timelineオプションを使ってインポートし、次の ADM をこのオプションを使ってイン
ポートします。このオプションではバイノーラル設定はインポートされません。このオプションを使ってイ

ンポートする全ての ADMは、同様の Input Configuration であるのが望ましいでしょう。
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プロジェクトにCDディスクが含まれている場合、インポートされたADMに対してCD Start と Stop マー
カーが作成されます。

● Create Strips for imported Beds and Objects - ミキサーに Beds と Objectsの新しい Strip を
作成します。新しい Stripは、タイムラインに作成された新しいトラックに合わせて、ミキサー内の既存
の Stripの前に挿入されます（上記参照）。

注意：ADM ファイルからダイナミック イベントをインポートし、対応する新しいストリップのパンニング メ
タデータに変換するには、このオプションを有効にする必要があります。

● Create Mono Strips for Beds -すべての Beds チャンネル用に Mono Strips を作成しま
す。チェックしていない場合、マルチチャンネルストリップが作成されます。

● Create new Busses for imported Beds and Objects - ミキサーに新しい Bus を作成し、作成さ
れたすべての Strip を自動的にこれらの Busにパッチします。このオプションを選択すると、既存のミ
キサーが完全に削除されます。

● Send imported Beds and Objects Strips to existing Busses - インポートした Beds と
Objectsの Strip を既存の Busへ送ります。Bedsは Mix Busに送られ、Objectsは Object Busに
送られます。

このオプションを使用する場合は、Dolby Atmosに対応するミックスバスをあらかじめ用意しておく必
要があります。

● Do not send imported Beds and Objects Strips -新しい Stripのみを作成し、既存の Busに手
動でパッチしたい場合に選択します。

注意: “Create Busses for imported Beds and Objects”オプションを使用すると、インポートしたADM
ファイルに対応するために新しいミキサーが作成されます。上記の両方のオプション（Create Strips と Create
Busses）を使用してインポートした直後にDolby Atmos ADM Masterをエクスポートすると、オリジナルと（ほ
ぼ）同様のADMが作成されます（詳細は「Dolby Atmos ADM Masterのエクスポート」を参照してください）。

注意: “Send imported Beds and Objects Strips to existing Busses”オプションを使用すると、
Objects Binaural Render Mode だけがパッチされた Objecr Busにインポートされます。既存の
Beds/Mix Bussesは Binaural Render Mode設定を変更しません。

Options
● Keep original Master Configuration including unallocated channels -現在の Project /

Mixerにないチャンネルのファイルをインポートする場合に使用します。このオプションは、同じ Project
/ Mixer を使って複数の Dolby Atmos ADM Master ファイルをインポートする場合に使用します。複
数の ADM Master ファイルをインポートする場合は、Paste on existing tracksオプションもチェック
してください。

● Limit number of unallocated Objects channels to - Object Strip を加える場合の最大値を決
めます（最大128）。同じ Projectに複数のマスターファイルをインポートする場合に便利です。
使用制限：インポートした ADM マスターファイルの最後のチャンネルが Beds だった場合、機能しませ
ん。

● Optimize Master Configuration by removing unallocated channels - インポートした ADM
マスターファイルから定義されていないチャンネルを削除します。

● Set Frame Rate according to Master - インポートした ADM マスターファイルのフレームレートに
変更します。
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● Create CD Markers fitting Master boundaries - ADM マスターファイルのインポート時に CD
Start と Stop を加えます。
Projectに CD Albumが無い場合は、新しい CD Albumが加えられます。
Projectに CD Albumが有る場合は、CD Markerが CD Albumに加えられます。

必要なオプションを選択したら、Import Masterボタンをクリックしてください。Pyramixはファイルをインポート
し、ミキサーを作成します（ Mixer Settingsオプションに従って）。
チャンネル数とダイナミックイベントの量によりインポートにかかる時間が異なります。
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Editing a Dolby Atmos ADM Master Configuration
Dolby Atmos Master Configurationは、チャンネル（Beds、Objects）だけでなく、Binaural, Downmix, Trim
の設定も Dolby Atmos ADM Master Configurationの一部として設定または変更できます。

フォームは Mixerに基づいて入力され、基本的に Dolby Atmosのコンフィギュレーション全体を保持します：

● Bedsは Mix Busから作成されます。

● Objectsは Object Busから作成されます。

● Bedsのチャンネルは Mix Bussesのチャンネルから自動的に派生します。
ボトムレイヤーのチャンネルは Dobly Atmos Beds または Dolby Atmos Objects としてエクスポート
されます。

ミックスバスの トップレイヤーチャンネルとワイド チャンネルは、常に Objects としてエクスポートさ
れます。

● Objectのダイナミックイベントは、Objectバスにパッチされた Stripのパンニングオートメーションとな
ります。

● Dolby Atmos Configuration全体は、どの Bus をエクスポートするかを選択し、どのマッピングモード
を Bedsにするかを選択し、選択したチャンネルごとにバイノーラルレンダリングモードを選択するだ
けで、上記のアーキテクチャから導き出されます。

● Configuration で Bed + Object Mode で選択されたミックスバスは、ADM マスターに Bed を作成し
ます。

7.1.xバスは 7.1 bed と x個の Top Object 、5.1.xバスは 5.1bed と x個の Top Object 、ステレオバ
スは 2.0 bed を作成します。
9.1.xバスは 7.1 bed と 2つのWide Object と x個の Top Object を作成します。

● Top とWide チャンネルは、Objects としてエクスポートされます。

● Configuration でBed + Object Modeで選択された追加のMix Bussesはマスターに追加の Bed を
作成します。

● 上記のルールには1つ例外があります。7.1.2 Mix Busは完全に 7.1.2 Bedsにマップされ、これらの
Bussesに Objectは作成されません。Top チャンネルを含む他のミックスバスは、すべて Objectsに
マップされます。

● Configuration で All Objects として選択されたバスは、ADM マスターに Objects だけとして作成され
ます。ただし、LFE を含んでいる場合は、ADM マスターに 5.1 bedが作成され、LFEはそこに送られ
ます。

● Configuration で選択された Objectバスは、Objects としてエクスポートされます。これらのObjectの
ダイナミックイベントは、この Objectバスにパッチされている Stripから抽出されます。

● 同じ Strip を共有するすべての Objectsは、CDのすべてのトラックで同じバイノーラル設定を持ちま
す。

Note: Auro 3D レイアウトのバスは、Edit Dolby Atmos Master Configuration と Export Dolby
Atmos ADM Master で Dolby Atmosにマッピングできます。

Project > Edit Dolby Atmos Master Configuration を開きます。
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Input Configuration & Binaural Render Mode
● Bus Channel -すべての Mixer Bus と Bus Channel を作成された順番で表示します。

この順序は、ADM マスターファイルにエクスポートされる順番と同じです。

● Assignment - どの Bus でも Dolby Atmos Configurationにマッピングできます。
○ None - Dolby Atmos マスターにエクスポートされません。
○ Bed + Top/Wide Channels as Objects -全てのボトムレイヤーのバスは Dolby Atmos

Bed として、Top レイヤーとWide チャンネルは Objects としてエクスポートされます。
○ All Channels as Objects -全てのチャンネルは Object としてエクスポートされます。LFE

はメインの Bedの LFE としてエクスポートされます。
○ Only Enabled Channels as Objects - Object Busにルーティングされているチャンネル

のみが Objects としてエクスポートされます。

● Description - Dolby Atmos Masterにエクスポートされる全てのチャンネルの詳細です。この情報は
読み取り専用で、Mixerの Strip と Busに基づいています。
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● Group - Group フィールドです。Bedの全てのチャンネルは同じグループになります。Objectsは、各
チャンネルが異なるグループとなります。

● Binaural Render Mode - エクスポートされる Dolby Atmos Master Input Configurationにエクス
ポートされるバイノーラルレンダリングモードです。

複数の Bed を含む Dolby Atmos マスターファイルのバイノーラル設定に関する注意：
バイノーラルレンダリングモードの設定は、ADM Master ファイルに含まれる複数の Bed と同じでなけ
ればなりません；

例えば、Bed 1の L チャンネルが Nearに設定されている場合、次の Bed でも L チャンネルが Near
に設定されます．

違いが検出されると、Pyramixはエクスポートされるバイノーラル設定を表示し、その設定が適用され
るベッドの詳細を表示します。

例：Near ->Mid (Overridden by Bed 1-10)は、Nearの設定が "Bed 1-10" という名前の Bedか
ら継承された Midに上書きされることを示しています。

Top チャンネルは Pyramix では Objects となるため、この動作の影響を受けません。

Downmix and Trim Controls
Downmix and Trim Controls は、Dolby Atmos Rendererの設定ダイアログと同様に設定できます。

Update Dolby Atmos Renderer
現在の Mapping, Descriptions, Groups, Binaural Settings, Downmix and Trim Control Settings, Mixer
Bus output routingは、Pyramixの設定に合わせて Dolby Atmos Rendererに送信されます。
このボタンは、Dolby Atmos Connect機能を使って Pyramixが Dolby Atmos Rendererに接続されるまで
有効になりません（後述の “Using Pyramix with a Dolby Atmos Renderer” を参照してください）。Dolby
Atmos Renderer 3.7（またはそれ以上）が必要です。

Export Configuration as ADM
現在の Input Configuration, Binaural Settings, Downmix and Trim Control Settingsは、Dolby Atmos
Master Configurationから "空の" ADMファイルとしてエクスポートし、Dolby Atmos Renderer でインポートし
て Pyramixの設定に合わせることができます。
Dolby Atmos Renderer でインポートした後、INPUT Sourceボタンを選択して Pyramix出力を聴いてくださ
い。

Pyramix でエクスポートした最終的な Dolby Atmos ADM Master を Dolby Atmos Renderer でインポートし
て設定しても、同じ結果が得られます。もちろん、コンフィギュレーションだけをエクスポートする方がはるかに速

く行えます。

Number of bus channels connected to the Dolby Atmos Renderer Input
Dolby Atmos Connect機能を使用する場合、Pyramix ミキサーバスの出力ルーティングは、設定された
Dolby Atmosマッピングに基づいて自動的に設定され、Dolby Atmos Renderer入力に送信されます。
未使用のバスチャンネル（MappingがNoneに設定されたチャンネル）には出力が割り当てられず、Dolby
Atmos Rendererにルーティングされません。
この設定では、このような自動ルーティングが適用されないバスチャンネル番号を定義できます。

例えば、有効な Dolby Atmos マッピングを持つ26のバスチャンネル（10chの Bed と16chの Objects）があ
り、Dolby Atmos Rendererに送る必要のない追加バス（プリレンダラ・モニタリング、カスタム・ダウンミックスな
ど）があったとします。

Update Dolby Atmos Renderer を使用すると、Dolby Atmosマッピングがないすべてのバスチャンネルの
ルーティングが削除されます。
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Dolby Atmos Renderer Inputに接続されているバスチャンネル数を26に設定した場合、Update Dolby
Atmos Rendererは26以上のチャンネルのバスルーティングを変更しません。

Note: この設定はグローバルなもので、特定のプロジェクトにリンクされていないため、ユーザーは同じオーディ
オセットアップを維持できます。

例えば、Dolby Atmos Rendererが外部のコンピュータにあり、Pyramixから Dolby Atmos Renderer をホス
トしている ASIO または VAD コンピュータに 64chの AES67/ RAVENNA チャンネルを接続している場合、
Dolby Atmos Renderer入力に接続されているバスチャンネル数を 64に設定します。Pyramix と Dolby
Atmos Rendererの両方が Merging Audio Device ドライバを使用して同じコンピュータ上にある場合も同様
で、このチャンネル数は MAD で設定したブリッジチャンネル数に従って設定できます（List Bridge channels
before I/O'sオプションを使用）。

Exporting a Dolby Atmos ADM Master Configuration
このプロセスは、既存のミキサーを通して、既存のタイムラインの Mixdown を生成し、Dolby ADM Atmos
Master ファイルとしてWrap します。

Project > Export Dolby Atmos Master Configuration を開きます。

Master
● Master Name - Masterの名前を決めます。ファイルは <Master Name>.wav という名前になりま

す。
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● Media Folder - Master ファイルを作成する先のフォルダーを決めます。

Timelne Source
● Whole composition - タイムライン全体を Dolby Atmos ADM Master ファイルにします。
● Between Marks - Mark In と Mark Out間が Dolby Atmos ADM Master ファイルになります。
● Selection -選択した部分が Dolby Atmos ADM Master ファイルになります。
● CD Tracks - CD Album情報をベースにタイムラインをエクスポートします。

このオプションは CD/SACD タブに CD albumが作成されている場合のみ使用できます。
○ Single ADM :全ての CD Tracks(CD Album) を１つのファイルにします。
○ One ADM per track : 1つの CD Track毎に ADM Master を作成します。
○ Track Number: Track Name :選択している CD Trackが入っている１つの ADM Master

を作成します。

● Naming : エクスポートされる CD Tracksの命名規則を設定します（ソースが CD Trackに設定され
ている場合にのみ適用されます）。

Note: カスタムネーミングは現在まだ使用できません。

● Default : DiscPerformer_DiskTitle_TrackNumber_TrackTitle (CD/SACDタブの Track
Name)

● Apple Music: Disc_UPCEAN_DiscNumber_TrackNumber
● Siny Music : TrackNumber_TrackTitle_ADMBWF(TrackTitle = CD/SACDタブの Track

Name))
● Universal Music :

DiscPerformer_TrackNumber_TrackTile_AtmosMix_Tempo_MixerInitial_StudioLocati
on_000bpm_BIMD
tempo と Studio locationは Pyramix で加えることはできません。適正な情報をファイルに
入れてください（TrackTitle = CD/SACDタブの Track Name）

● Warner Music :
TrackNumber_Disc_UPCEAN_TrackISRC_AudioSampleRate_AudioBitDepth

● Adjust CD Markers to Video Frames (CD Track モードのみ) - CD Marker をビデオフレームに
合わせます。CD Startは、ひとつ前のビデオフレームになり、CD Stopは、ひとつ後のビデオフレー
ムになります。

この設定は、Dolby Atmos Renderer で Start Time/FFOAの問題を避けるために強く推奨されま
す。

開始時間はビデオフレームに合わせるか、FFOAを開始時間より少なくとも1フレーム大きくする必要が
ありますが、必ずしも合わせる必要はありません。

Note: エクスポートされたマスターは、上記のソースポイントのタイムラインエントリーポイントに従ってスタートタ
イムが設定されます。 First Frame of Action: エクスポートされたセレクションのスタートポイントとエンドポイン
トの間にFFOAという名前のマーカーがタイムラインに見つかった場合、それはエクスポートされたADMマス
ターファイルの First Frame Of Action を設定するために使用されます。
FFOAは CDインデックスマーカーを使って CDトラックに挿入することができます。このような CDインデックス
には FFOA という名前を付ける必要があります。

Note: CDアルバム情報のみが使用されます。SACDアルバム情報は使用されません。
使用したい場合は、SACDディスクを選択し、CD/SACDタブの Discsメニューの SACD Discから CD Disc を
作成してください。

Note: CDアルバム、マーカーなどの詳細については、CD Masteringの章を参照してください。
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Master Configuration
Master Configurationグリッドでは、Dolby Atmos ADMマスターファイルにエクスポートするバスを選択した
り、Dolby Atmosマッピングモードやバイノーラルレンダリングモードを設定したりできます。
このマッピングの詳細は、上記の “Edit Dolby Atmos Master Configuration”のセクションを参照してくださ
い。

Important Note：オーディオを含まないチャンネルは、最終的なADMマスターファイルにはエクスポートされま
せんが、チャンネル番号とソースインデックスは保持されます。

これらのチャンネルはグレーアウトされ（empty）のメッセージが表示されます。

Edit Master Configuration：ダウンミックスやトリム・コントロールなどの追加設定を行うための Master
Configurationウィンドウを開きます。詳細は上記の “Edit Dolby Atmos Master Configuration” を参照し
てください。

Processing
Real time Mix - ミックスダウンのプロセスをリアルタイムで実行します。ミキサーに外部センド/リターンやイン
サートが入っている場合に必要です。

Export Master
必要な設定をすべて行ったら、Export Master を押してミックスダウンを開始します。
ミックスダウンの詳細については、Mixer - Mixing Down Projects セクションを参照してください。
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Using Pyramix with a Dolby Atmos Renderer (DAPS/DAMS/HT-RMU)

一般的なDolby Atmosプロジェクトは、Beds（Stereo、5.1、7.1.2などのチャンネルベースのバス）とObjects
（パンニングのメタデータを持つモノラルサウンド）の組み合わせで構成されます。

コンテンツ制作者は通常、Dolby Atmos Rendererに正しい Input Configuration を設定することから始め
ます。Renderer を起動し、Window > Input Configuration を選択します：

Dolby Atmos Renderer

映画やテレビのポストプロダクションの Input Configurationは、下のスクリーンショットのように、ダイアログ、
FX、ミュージックの 3つの Beds と、ダイアログ、FX、ミュージックの Objects セットが作成されます。

Dolby Atmos Renderer - Input configuration

これにより、クリエイターは 5.1/ステレオ/その他を制作することができます。Dolby Atmos Rendererから3つの
主要グループ（DIA/FX/音楽）の Re-renders（またはミックスダウン）を行います。
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音楽のワークフローでは、1つの Bed と 1組の Objects だけを使用することがあります。
Pyramixの Dolby Atmos Connect機能を使えば、Dolby Atmosの設定を Pyramixから Dolby Atmos
Rendererに直接エクスポートできるので、この設定作業が簡単になります。
以下の “Connecting Dolby Atmos metadata from Pyramix to the Dolby Atmos Renderer”の章を
参照してください。

Input Bed Size v Playback Systems
Dolby Atmosの最大入力 Bedサイズは 7.1.2 ですが、再生システムは（劇場用を除いて）最大 9.1.6、さらに
は 11.1.8の構成が可能です。
つまり、入力 Bed構成は 7.1.2に制限されていますが、任意のスピーカーレイアウト（最大11.1.8）に広げるこ
とができ、Objectsは任意のスピーカーレイアウトにレンダリングできます。

Pyramixでネイティブの 7.1.2以上のバスサイズを使用して作業している場合、元の空間解像度を維持したま
ま Dolby Atmos で作品を楽しめるようにしたい場合は、Dolby Atmos input bedに “欠けている” チャンネルを
エミュレートする Dolby Atmos Object を作成することができます。

たとえば Pyramix で 7.1.4バスを使用して 7.1.4ネイティブで作業しているエンジニアが、Dolby Atmosバー
ジョンのサウンドトラックを作成したい場合があったとします。

Dolby Atmosの最大入力 Bedは 7.1.2 なので、Pyramix 7.1.4バスを Renderer側で 7.1 input Bed と4
Objectsにマッピングします。Dolby Atmos Rendererは次の図のように設定する必要があります：

Dolby Atmos Renderer - Input configuration
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Connecting Dolby Atmos metadata from Pyramix to the Dolby Atmos Renderer

Pyramix と Dolby Atmos Renderer間のワークフローを簡素化し、強化するために Dolby Atmos Connect
機能が導入されました。これにより、入力設定、出力ルーティング、Dolby Atmosマッピングなどを Pyramixか
ら Dolby Atmos Rendererに送信して同期させることができます。
Dolby Atmos ADM Master を生成して両方のアプリケーションを同じ設定にする必要はありません。

Note： Dolby Atmos Render 3.7（またはそれ以上）が必要です。

Pyramix と RMU間のメタデータ接続を確立するには、Pyramix Mixerの右上にある Dolby Atmosボタンを
クリックします。

ネットワーク上またはローカルで動作している Dolby Atmos Rendererが自動的に検出されます。
必要な Dolby Atmosサーバを選択して接続を確立します。
接続が完了すると、ミキサーのDolby Atmosボタンが緑色に点灯します。
接続を解除するには、Pyramix Mixer右上の Dolby Atmosボタンをクリックし、接続されている Dolby Atmos
サーバを選択します。

Advanced ….

Advenced メニューには、Dolby Atmos Renderer接続の現在の状態、エラー、ログメッセージが表示されま
す。

Serverボックスでは、Dolby Atmos Renderer をホストしているコンピュータの IP アドレスを手動で入力するこ
ともできます。

Update Dolby Atmos Rendererボタンもあります（Edit ADM Master Configurationのボタンと同じ）。
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別の例として、Pyramixユーザーがワイド レフトとワイド ライトをネイティブでミックスするケースが考えられます：

これらのチャンネルは Dolby Atmos Rendererの入力Bed （最大Bedサイズ：7.1.2）の一部として使用するこ
とはできませんが、例えば 9.1.4 スピーカ・レイアウト（下記参照）では使用できます。

Bedsがそのスピーカーに広がることはなく、Objects だけがそのスピーカーにレンダリングされます。そのため
Pyramix では、上記の説明と同様の方法で、Pyramix Wide L/R を Dolby Atmos Rendererの Objects入力
チャンネルのペアに接続することができます。Pyramixは、Objects を正しい位置に配置するための適切なメタ
データを自動的に送信します（この場合、Wide Speakers座標）：
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Note：（Dolby Atmos Connectウィンドウを使って）Pyramix と Dolby Atmos Renderer間のメタデータ接続が
確立されると、すぐに Pyramixは Dolby Atmos Rendererが Pyramixの出力チャンネル 1以降に接続され
ているとみなします。

したがって、Dolby Atmos Rendererに送られる音声は、Pyramixのチャンネル 1以降から送られる必要があ
ります。これにより、特定の Objectのオーディオとメタデータが、Dolby Atmos Rendererの正しいチャンネル
でレンダリングに送信されるようになります。

Anemanや MAD（Merging Audio Device）を使用したクロスパッチは、オーディオと一緒にメタデータを受け取
らないので、これは解決策にはなりません。

Dolby Atmos Mapping, Dolby Atmos Description, Dolby Atmos Groupは、Pyramixの Project > Edit
Dolby Atmos Master Configurationページで編集できます。これらの設定は、接続を確立するときに
Pyramixから Dolby Atmos Rendererに送信されます。すでに接続が確立されている場合は Update Dolby
Atmos Rendererボタンを押したときに送信されます。

Note：Auro 3Dレイアウトのバスは、Edit Dolby Atmos Master Configuration でマッピングでき、 Export
Dolby Atmos ADM Master でエクスポートできます。

Binairal
Dolby Atmos Rendererの設定プロセスの一環として、Binaural Render Modeの設定を行う必要がありま
す。この例では、「エミュレートされた天井のチャンネル（Objects）」が最下層のレイヤー（Bed）と同じ設定になっ
ていることが確認できますが、これは完全にクリエイターの好みに任されています。

Biraural Renderの設定は、Pyramixから Dolby Atmos Rendererに転送することもできます。

LFEチャンネルの注意：
通常、LFE Channel Binaural Renderモードは OFFに設定します。
LFEチャンネルバイノーラルレンダリングモードが OFFに設定されていない Dolby Atmos ADM マスターを
Pyramix でインポートした場合、Pyramixはこの設定を変更しません。Edit Master Configuration ダイアログ
でこの設定を OFFに変更するか、そのままにしておくことができます。
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複数の Bedが含まれた Dolby Atmos Master ファイルの Binaural Settingsの注意：

● Binaural Render Modeの設定は、ADM Master ファイルに含まれる複数の Bed間で同じでなけれ
ばなりません。

例えば、Bed 1の Lチャンネルが Nearに設定されている場合、次の Bed でも Lチャンネルは Near
に設定されます。

違いが検出されると、Pyramixはエクスポートされる Binaural settings を表示し、その設定が適用さ
れる Bed を表示します。
例：Near ->Mid (Overridden by Bed 1-10)は、Near設定が "Bed 1-10 "という名前のベッドから継
承された Midに上書きされることを示しています。

Top チャンネルは、Pyramixで Object として定義されているので、この動作の影響を受けません。
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Sending Pyramix Objects to the Dolby Atmos Renderer

Pyramix で Object Bus を使用する場合、Dolby Atmos Rendere rが使用されているかどうかにかかわら
ず、ワークフローはシームレスとなります。

Object Bus を作成することで、Objects を Dolby Atmos Rendererに送ることができます。

Pyramix Mixerの Configure をクリックし、Add Bus > General Mixing Bus をクリックします。 Object
Bus をクリックし、必要なチャンネル数を選択します。

Create General Mixing Bus dialog
Pyramixの Object Busはどんなサイズでも構いませんが、Mono Objectのグループとして見なければなりま
せん。サウンドトラックの様々な要素（Stem など）をグループ化した複数の Object Bus を作成することができ
ます。
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Object bus Mapping

Object Busは適切な Dolby Atmos Rendererの Onject Input マッピングするだけです。Pyramixは、さまざ
まな Pyramix Strip Pannerから Dolby Atmos Rendererに直接、個々のダイナミック／スタティックパンニン
グ メタデータ（ダイバージェンスを含んだ Dolby Atmos Object “size”にマッピングされる）を送信します。

Note：Pyramixの Divergenceは Dolby Atmos Size と等価であり、そのようにインポートおよびエクスポート
されます。

Stripから Object Busにルーティングするには、Stripの Object Router をクリックして Object busのチャン
ネルとします：
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Stripから Object Busへ
Stripがアクティブな Object Busにルーティングされると、オーディオはこの Object Busにのみ送られ、他の
バスには送られません。すべてのパンニングはメタデータとして Dolby Atmos Rendererに送られます：

Stripから Normal Busへ
Object Bus を非アクティブにすると（緑色のボタン）、この Object Busに供給されている Stripからのオーディ
オは、ルーティングされている他の Mix Busに送られ、メタデータは Dolby Atmos Rendererに送られなくなり
ます。(パナーは単に通常のパナーとして動作します）：
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その他の Dolby Atmos parameters
Trim and Downmixes, mapping, ...は、Edit Dolby Atmos Master Configurationページで設定できます。
詳細は ”Editing a Dolby Atmos ADM Master Configuration” をご覧ください。

Multichannel plugins
Pyramix ミキサーはマルチチャンネルプラグインをサポートしています。詳細はマニュアルの Effectの章を参
照してください。

VS3 プラグインのリストは、

https://confluence.merging.com/display/PUBLICDOC/VS3+Plugins

認定サードパーティ製 VST プラグインのリストは、次のサイトで入手できます（変更される場合があります）。

https://confluence.merging.com/display/PUBLICDOC/Third+Party+VST+Plugins+support
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